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Why a Service Flow Feature?

Many leading enterprises have chosen IBM Mainframes running CICS
software to provide service functions

— The proven strengths of CICS running on IBM mainframes has, over time, led to a huge
investment in CICS application code and skills that can be reused

— Performance and scalability of CICS business processing has been proven over 30 years
To be agile in today’s fast-moving marketplace, companies must embrace

modern architectures and new technologies while leveraging both people
and computing assets

— CICS maintains and adds value by enabling traditional, proven assets and processesto be
consumed as Web Services

— Unlock critical IT assets and re-purpose them to participate in a service oriented
architecture

— Opening access to existing fine-grained applications as coarse-grained business functions,
while maintaining QoS

— Provide a layer of abstraction between service consumer and application implementation /
user interface

— Foster SOA skills in traditional developers
Increase Productivity
— Build libraries of annotated components representing current assets

— Rapidly assemble new applications out of existing components using graphical tools
—  Exploit existing developer skills and literacy
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...continued
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What is XSE?

XML Services for the Enterprise is a
tool to adapt COBOL-based
applications so that they become
Web services and can process and
produce XML messages.

It allows you to:

—  Create a New Web Service Interface

—  Map to an Existing Web Service Interface

—  Create a New Web Service Implementation
Supported runtimes:

—  Web Service for CICS (CICS TS 3.1)
— SOAP for CICS (CICS TS 2.2, 2.3,3.1)
— IMS SOAP Gateway

— Batch, TSO, and USS

[ Web Service Runtime and Scenario Selection

Specify options to start a web service wizard

|Web Services for CICS

=]
=

Runtime:

Scenario: ICreaDe Mew Service Interface (bottom-up)

Conversion type: ICompiIed XML Conversion

Scenario description:

=@

Generate a Web service description and runtime specific XML message
processing from a high level language data structure. You can use this
option when you expose an application program as a service provider.

Start I

Cancel

(=¥ Web Services for CICS - Create New Service Implementation. ..

CICS Web Services Assistant

—

Specify new service provider or requestor properties

{ 1 Appiication Properties || 1 service Properties |

Specify new service
Application type:

1 properties
[service Provider

I=|
I=|

Application languags: [cosoL

[ squrmsr

[chanme.

I=|

Container name

[ sqwirmer

= Back

| | snish |

Cancel

The simplest mechanism for creating atomic Web Services
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What is SFM?

= Service Flow Modeler is a tool
to build service flows out of
your existing Commarea and
Terminal based CICS
applications.

= It allows you to:
— Model business or application processes

— Implement business processes by
aggregating multiple transaction
invocations, terminal interactions, and sub-

flows |

— Deploy these aggregations to runtimes in s
CICS Transaction Server V3.1 or e - ¢
WebSphere Application Server. T e

—  Choose to deploy business process as a b f-l @H’ d‘f‘)‘h
web service. S

= Development concepts consistent i !
with other SOA development tasks

e
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WDz's Service Flow Modeler
Deployment Options

CICs 3.1

Service
Interface

Deploy

ervice
I};‘:
WebSphere Developer for zSeries
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Choosing the Right Tool for CICS SOA

Feature

Host Access
Transformation Services,

Creates web user interfaces
from existing terminal based

WDz — Service Flow Modeler|

Assembles multiple commarea
and terminal based applications

WDZ — XML Services for
the Enterprise

XML and Web services
enablement for existing

applications into a single Web service commarea-based applications
Builds Web User Yes No No
Interfaces
Exposes screen Yes Yes No
applications as web
services
Exposes commarea No Yes Yes
programs as web
services
Supports assembly of No Yes No

multiple interfaces

z/OS Apps Supported

Any with 3270 interface

CICS BMS and Commarea

CICS Commarea

IMS Apps
WAS runtime Yes No No
CICS/IMS native No Yes (CICS) Yes (CICS and IMS)
runtime
Skills Eclipse/J2EE Integration Developer Integration Developer

COBOL/CICS/Eclipse

COBOL/IMS/CICS/Eclipse
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Components of the Service Flow Feature

= What is the SFF

— The CICS Service Flow Feature is a no-charge, orderable
feature for

CICSTSv3.1
— A business service integration adapter for all CICS
applications
. |[Decanerozen [ g
= Tooling h ¢
— A graphical modeling integrated L ﬂ
development environment } o

— WebSphere Developer for zSeries v6.0.1 i D

«  Service Flow Modeler e \g
* XML Services for the Enterprise (XSE) b

— Entitlement to 10 LIMITED product licences
= Runtime

— CICS Service Flow Runtime 3 - ul, $)

— Extends the CICS TS v3.1 environment.

— Offers adapters to invoke CICS commarea based programs and
terminal-oriented transactions
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What is a Service Flow?

I Service Flow

Input Output

ciCs cxes ciCs clEs
Commarea Commarea Terminal Terminal

= A service flow is a non-interruptible micro-flow that is
constructed from a collection of nodes that represent the
invocation of CICS resources

= The flow describes the navigation of the nodes and allows data
mapping between the nodes

= A single request may cause the execution of many CICS
resources

= Allows for the development of coarse grained services from fine
grained resources

9 © 2006 IBM Corporation



Software Group

Components of a Service Flow

| | Receive Input node for flow
U Reply Output node from flow

Q Throw Throw fault node
4.-9 Invoke Generic invoke (target not yet defined)
@5 Invoke Operation Invoke a non-terminal operation

@ Invoke Terminal Invoke a terminal screen operation
Invoke Flow Invoke a flow

= | Assign Map data between messages in the flow
W | Switch Flow control decision node
Q)) While Flow control loop node
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Development Model

Service Flow ﬂ

~

WSDL XSD

€] =Screens shown, but applies to transaction as well
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Deployment Model

CICS TS v3

L_SOABPIPELINE |

%rvice Flow Runtime

SOAP Client
at
JCA Client
WebSphere WebSphere MQ
MQ Client

[ 2o || o

WebSphere
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Using Service Flow Modeler

= Service Flow Project

— Create, store and maintain required resources.

 Interface Definitions, Terminal applications, Non-Terminal
applications

= Service Flow Model terminology
— Messages - data structures

* Screens, transaction inputs, transaction outputs, and web service
messages

— Message mappings - any transformation of data between messages
— Operations - EIS interaction

+ Screen submission, transaction invocation, and sub-sequence flow
Invocation

— Flows — composition of multiple operations and the message mapping

* Flow behavior is represented graphically
— Data movement is done through Message Mappings
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Gaining Perspective 0N SFM s

The Service Flow Modeler Perspective
is used for development

Access through the menu option
Window > Open Perspective > Other
or the toolbar button

Contains simplified project view and
necessary supporting views to access
all functions available in SFM

SFM Preferences are also available
which pertain to various functions

— Access through the menu option
Window > Preferences > Service Flow
Modeler

=]

[
ﬁDebug

(@ 2EE

g;J Jawa

5_’ Java Browsing

fngava Type Hierarchy

E\E Remote System Explorer

@Service Flow Madeler

G
Jﬁzﬁ’OS Projects (default)

™ ghow al

oK I

cancel |

=101 x|

[+~ Message Set A
Modeling

- Process

Remiote Systems
[ Run/Debug

[l Wb and KML

[+ wieb Diagram

[+ Web Tools

[+ ML Services Far the Enterp
[ 2/223 Solutions -
4| | &

‘ Service Flow Modeler

¥ gutomatically capture new screens

Recarding in the Host Editor
’;7 Da nat prompt For name when automatically capturing screens

Time to wait before attempting screen recognition {miliseconds) I soo

Recording Flow
Do naot prompt For variables when generating variable mapping

I™ show Welcome dialog when petspertive opens

Restore Defaulks Apply

Import... Export...

© 2006 IBM Corporation



Software Group
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s W |5 W@ - || 4 —Palette —
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= \ Connection inmsg {

(= Flows ! e
LookupPhoneFlow. seqflow . Receive
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B& apping || Throw

I
al; LookupPhaneFlow.seqmap E A = =
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=
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[#1-[= Generation 'c>) While

1 SFMDemo. Intf

= gt (nyalins

B getPhoneFlow
~ - getPhoneFiow vsdl

w2 lookupPhhumService wsdl

[z=- Operations
= Messages
SFMDemo. Commarea

||| Graph
- Operations

-7 lookupCustomerService, wsd| Elproperties £

, (5 Macesnas
‘l = L | _IJ Propert: |Va\ue

5= outline &2 18 | = =0
=+ LookupPhoneFlow
inmsg
gj oukmsg
¥ getA counthum
ESSECE LT AT
2 Assign
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Development [

B welcame to SFH gd
1 —Palette —
1 % Selection
\ Connection ﬂ
5E
.URecewa i
orderVIPShipping
4 Reply
H ity shippinglnfa
G 2 PO —&
(‘) Invoke retrievqCustamer isWIP orderRegularshipping
3 Assign
o Switch
2 cuszacnce NG — |
Operations Editor Error
Operations
= =3
=] Port 'I'yp::g 2] processorder. seqflow ‘ ’pmcessorder retrieveCustomer, seqmap \
=@ OP” Tel*pracsssOrder.seof -\ =
T processOrder, seqflo qmap
E msg_ST ESource D G T v [ Target ‘ el B14G v
= Output Structure: | Type 1 13
T petcust " =14 ¥ msq_biling (bilingInfo) =} E msg_DFHCOMMAREA {DFHCOMMAREA) =
[ msg U _ getcust, mxst (€] ¥ customeriame [8]  customerhumber
Faults = agESSTOCK —[€] ¥ addresst [&] " Firstiame
o ~[8]  address2 [8] lasthame
(€] ¥ ity [e] " streetaddress
e [€] 4 state &l " dity b
e [€] ‘ €] " state
(8] creditcardnum [8] country
(8]  ccExpDate ¥ zipCode
phonetlumber ﬂ

) xsd:string -
[E] strestAddress
[E city

[E] state

[E country

[€ zipCode

[€ phonetumber
[E returnCode

[ numberCfstoc,,,
5 sd:short -
[E guantityOfShares
[el strrkswmhinle

Overwewl Properties ‘

I Overvisw m s} ’E -
Target | Source | Target valug |
[=F 1 msg_DFHCOMMAREA (DFHCOMMA, .. [ msg_biling (bilingInfo)

[€] firsthiame [E] customerName SUBSTRIMG(s_msqg_billing.customarMame ...

[e] streetaddress [e] addresst s_msg_billing. address1

[&] city (] city s_msg_billing.city

[€] state [E] state s_msg_blling. state

[e] zipCade [e] zip s_msg_biling. zip
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Mapping Editor

[« I Exp

Use source or target fields and functions to create value for target &{%

Mapping: ca_userid --> ca_userid
Value of target field: t_msg_CAPLACEORDER.ca_order_request.ca_userid

's_msg_PLACEORDERREQUEST.ca_userid

¥ Apply Condition

ls_msg_PLﬁCEDRDERREQUEST.Ca_userEd IS NOT NULL

Source fields L‘E |String Functions

0K | Anply | Cancel |
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JCL

>Artifacts

7

CICS

Business

Service
I 4

EIS Applications
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Runtime Architecture

~
MQ Put/Get WebSphere
DPL (Commarea) Commarea

Terminal
Based

Link3270 Bridge

-—ee—— e o = Em = == m P

Link3270

~

—— e = = o= o=

BTS Process

CICSTSv3.1

Key - W SFM Generated
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Invoking a CICS Business Service

SOAP Enagled OAP PIPELINE

 WEBSERVICE L _CMMarea

I i i | . | CICS Transaction | Commarea

Commarea

Commarea

CIC,
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Invoking a CICS Business Service

Flow Invoked through program DFHMADPL
Message passed from Service Requestor to CICS SFR

Maximum CICS SFR message length 32,500

A
- N
Message L
Header Application Data
I\ AN >
Y ~"
384 bytes

32,116 bytes
Message Header contains request and reply
* Request Name, Data Length

¢ Return Code, Error Message
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CICS Service Flow Feature and IBM
SOA with WID

= Common artifacts
— WSDL
— XSD

= Common Developer experience

— Eclipse based tooling

— Common modeling constructs

* Receive/Reply
* Invoke
*  Switch

= Easy integration of Service Flow

...An example with
IBM WebSphere Integration Developer (WID) follows ...
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Import deployed WSDL in WebSphere
Integration Developer

B BX lingme S Propct

Process Server
Business

Telansll FAN NS
Process [
s Wy |laas
Eibwcae s :
hebreceFu. ® W
. Invoke SFM's -z e Service
I papmem— WebService £ pebimtmiictiy s |nterface
mpor using imported ® et N _“"
generated o — Wm“ :
WSDL - P
AfLTen
e
AConmdaton et B
Service
Interface
=
Similar
development
units (such ES
1
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Where to get more information?

= WDz Help -> Help Contents

— Developing z/OS applications and Web Services
interfaces

— Topics and Tutorials

= CICS TS 3.1 Infocenter

— http://publib.boulder.ibom.com/infocenter/cicsts/v3rl/index.|
Sp
— Access to CICS

«  CICS Web Services
* CICS Internet Guide

— CICS Service Flow Runtime

= IBM WebSphere Application Transformation Demos
— http://lwebsphere.dfw.ibm.com/atdemo/atdemo_wsed.html
— Viewlet Demos available for download
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SFM Demo Descriptions

Scenario 1: This is a demonstration of the rapid application development capabilities
of the Service Flow Modeler component of WebSphere Developer for zSeries v6.0.1.
In this demo, we quickly implement a new CICS application by aggregating existing
COMMAREA programs, then expose that application as a Web service.

Scenario 2: This is a demonstration of the rapid application development capabilities

of the Service Flow Modeler component of WebSphere Developer for zSeries v6.0.1.

In this demo, we quickly implement a new CICS application by automating the

U\z;lvg)gatior] of an existing 3270 terminal application, then expose that application as a
eb service.

Scenario 3: This is a demonstration of the flexibility and rich functionality of the
Service Flow Modeler component of WebSphere Developer for zSeries v6.0.1. In this
demo, we show how a business analyst can model a workflow which will implement a
specified Web service definition. Then, we show how an application developer can
implement that workflow out of existing CICS applications, both terminal and
nonterminal. Finally, we show a systems programmer deploying this service to the
CICS Service Flow Runtime.
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